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Revision History

Date Description

July 23,2019 Added MCDEV-11430 and MCCET-3110 to Limitations.

IMPORTANT: Avid periodically makes software updates available for download on
Avid.com at the following location:www.avid.com/us/support/downloads. Please
check the above site regularly for information on available downloads for your
product.

Important Information

Avid® recommends that you read all the information in this ReadMe file thoroughly before
installing or using any new software release.

Important: Search the Avid Knowledge Base for the most up-to-date ReadMe file, which
contains the latest information that might have become available after the documentation was
published.

This document describes compatibility issues with previous releases, software installation
instructions, hardware and software requirements, and summary information on system and
memory requirements. This document also lists hardware and software limitations.


http://www.avid.com/support/downloads
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Symbols and Conventions

Avid documentation uses the following symbols and conventions:

Symbol or Convention Meaning or Action

A note provides important related information, reminders,
recommendations, and strong suggestions.

& A caution means that a specific action you take could cause harm to
your computer or cause you to lose data.

@ A warning describes an action that could cause you physical harm.
Follow the guidelines in this document or on the unit itself when
handling electrical equipment.

> This symbol indicates menu commands (and subcommands) in the
order you select them. For example, File > Import means to open the
File menu and then select the Import command.



If You Need Help

Symbol or Convention Meaning or Action

b This symbol indicates a single-step procedure. Multiple arrows in a list
indicate that you perform one of the actions listed.

(Windows), (Windows This text indicates that the information applies only to the specified
only), (Macintosh), or operating system, either Windows or Macintosh OS X.

(Macintosh only)

Bold font Bold font is primarily used in task instructions to identify user interface

items and keyboard sequences.
Italic font Italic font is used to emphasize certain words and to indicate variables.
Courier Bold font Courier Bold font identifies text that you type.

Ctrl+key or mouse action  Press and hold the first key while you press the last key or perform the
mouse action. For example, Command+Option+C or Ctrl+drag.

If You Need Help

If you are having trouble using your Avid product:

1. Retry the action, carefully following the instructions given for that task in this guide. It is
especially important to check each step of your workflow.

2. Check this ReadMe file for the latest information that might have become available after the
documentation was published. Also check online for the most up-to-date ReadMe because
the online version is updated whenever new information becomes available. To view the
online ReadMe, select ReadMe from the Help menu, or visit the Knowledge Base at
http://www.avid.com/readme.

3. Check the documentation that came with your Avid application or your hardware for
maintenance or hardware-related issues. In addition to the printed documentation supplied
with your editing application, the documentation is supplied in PDF format when you install
the application. Topics that you print from the Help have limited page layout and formatting
features. If you want to print a higher quality version of Help information, Avid recommends
that you print all or part of the PDF version of the appropriate Avid manual included in the
Online Library for your editing application. To access the Online Library, select Help >
Online Library from within your Avid editing application.

4. Visit Avid Online Support at www.avid.com/onlineSupport/. Online support is available 24
hours per day, 7 days per week. Search the Knowledge Base to find answers, to view error
messages, to access troubleshooting tips, to download updates, and to read or join online
message-board discussions.


http://avid.force.com/pkb/articles/en_US/readme/Media-Composer-Software-8-0-Documentation
http://www.avid.com/onlinesupport
http://www.avid.com/onlinesupport
http://www.avid.com/onlinesupport

If You Need Help

Media Composer Notes

> bbb

(Windows) If you are installing the editing application and you have a previous version of the
editor on your system, go to the Control Panel and manually uninstall the editing application
before you try and install v2019.7.

Media Composer v2019.7 is not supported with Media Composer | Cloud Remote.

MCDEV-11537 If you intend to use full-frame stereoscopic with an Avid Artist DNxIQ, you
may want to remain with Media Composer v2018.12.x until the issues with Stereoscopic
support are resolved in a future version.

(Mac) You might receive an “Is not optimized for your Mac” message while launching
Media Composer for the first time on a Mac OS 10.14.x system. Press OK to continue.

e (MCCET- 2541) When working with Avid Artist DNXIO or Avid Artist DNxIQ, you should
disable the Line In recording input (BlackMagic Audio in the Windows OS).

*  Avid recommends that you do not install Desktop Video software version 10.10.1 on Media
Composer versions prior to v2018.5.1.

*  Avid Artist DNxIO and Avid Artist DNxIQ: If you are using Avid Artist DNxIO, Avid
Artist DNxIQ, or a BlackMagic Designs video device, please update to Desktop Video
software version v11.0 or higher. If you are using Avid Artist DNxIV and Avid Artist DNxIP
please update to AJA software v15.2 or later.

*  Qualified Operating Systems: For information on qualified operating systems, see
Qualified Hardware and Operating Systems.

*  Dongle Info (Mac Only): The Dongle Sentinel driver installer is no longer automatically
installed when you install the editing application. The driver is now located in the
Avid_Utilities folder (/Applications/Utilities/Avid_Utilities/Sentinel_Driver). If you have a
dongle, manually install the driver from this location.

When installing the Sentinel Driver, check your System Preferences and select “Security
and Privacy.” You may need to choose to Allow the driver to be accessed.

*  NVIDIA drivers are no longer included with the Media Composer installer. You must access
the Nvidia website - Nvidia.com to download the applicable driver. See the Compatibility
Chart for tested driver version with this release.

¢ NVIDIA Driver:

Avid recommends that if you are on a Windows 7 system and working with the Nvidia
driver, you should enable desktop composition. See this article for details:


https://www.nvidia.com/Download/index.aspx?lang=en-us

Changed in Media Composer v2019.7

http://avid.force.com/pkb/articles/en_US/how_to/Enable-Desktop-Composition-in-Window
s-7

«  MCDEV-11537 If you intend to use full-frame stereoscopic with an Avid Artist DNxIQ, you
may want to remain with Media Composer 2018.12 until the issues with stereoscopic
support are resolved in a future version.

Changed in Media Composer v2019.7

Media Composer v2019.7 has been tested with Nvidia driver v431.02. Although Avid tested and
recommends this version, you are not limited to this driver. You can access your graphics card
website for information on the driver matching your card. Please note that Avid can not
guarantee Media Composer will operate as expected when using an untested driver version. You
may need to install the tested driver version when attempting to resolve technical issues.

Fixed in Media Composer v2019.7

The following have been fixed:

»  Bug Number: MCCET-2905. Using the arrow up and arrow down keys to move clips from one
track to another did not work when a nested effect was open.

»  Bug Number: MCCET-3016. Audio meters did not display in the Audio Tool, Audio Mixer or
Timeline window during a Digital Cut.

»  Bug Number: MCCET-2986. In some instances, adjusting audio level from the Audio Mixer,
while playing a sequence, did not affect the volume.

»  Bug Number: MCCET-3006. (Windows) Media Composer would crash when importing
embedded AAF into a 25fps HD project.

»  Bug Number: MCCET-3112. (Script View) In some instances, Media Composer would crash
when scrolling in a large bin and while playing in the Source/Record monitor.

»  Bug Number: MCCET-3003. You could not rename group clip tracks.

»  Bug Number: MCCET-2899. All related media object were not highlighted when selecting
media relatives if you grouped clips and selected Select Sync Clips Using “Film TC/Sound TC”.

»  Bug Number: MCCET-3031. In some instances, when I/O hardware was enabled, you could
not import/transcode to AVClntra50.


http://avid.force.com/pkb/articles/en_US/how_to/Enable-Desktop-Composition-in-Windows-7
http://avid.force.com/pkb/articles/en_US/how_to/Enable-Desktop-Composition-in-Windows-7

Fixed in Media Composer v2019.7

Bug Number: MCCET-3036. When working with an HD 1080p 25 project, transcode options
changed if I/O hardware was enabled/disabled.

Bug Number: MCCET-3032. You might have received an “Exception: No Source” error when
performing a video mixdown and choosing over/under as a Stereoscopic option.

Bug Number: MCCET-3086. You could not copy and paste markers using Ctrl + C and
Ctrl + V.

Bug Number: MCCET-3059. You could not save newly created and renamed shared bins in
project sub folders.

Bug Number: MCCET-3041. If you pressed ESC a few seconds after performing a trim, the
Timeline did not update correctly.

Bug Number: MCCET-3026. When consolidating a subclip with “Delete original media files
when done” enabled, an unrelated Transcode notification message was displayed.

Bug Number: MCCET-3073. AAF exports did not include the media if the clip was muted.

Bug Number: ETE-1512. A dark gray fill (instead of black) is provided now in the viewer for
Pillar and Letter box areas that are not masked.

Bug Number: MCDEV-11146. Removed Show Position and Show Effect Contents from the
Timeline settings.

Bug Number: MCDEV-8227. When switching between MXF and OMF media types in the
Media Creation window, the window would not refresh until it was reopened.

Bug Number: MCDEV-8527. The Tool Palette moved position after resizing.

Bug Number: MCDEV-10060. Precomputes were lost when reentering the Avid Titler+Title
tool.

Bug Number: MCDEV-10346. An asterisk might have appeared in the Bin name even if no
changes had been made to the bin.

Bug Number: MCDEV-10412. You might have experienced problems loading sequences with
Avid Titler+ titles between Windows and Mac systems.

Bug Number: MCDEV-10512. Avid Titler+ characters did not maintain relative position
between each other during animation playback.



Fixed in Media Composer v2019.7

Bug Number: MCDEV-10624. Scrolling in Text view in a bin was column by column rather
than by pixel.

Bug Number: MCDEV-10632. Even when a change was made, the Bin View name did not
display in italics to indicate a change to the view had been made.

Bug Number: MCDEV-10801. Changing the sequence name in Frame View did not update the
name in the Composer monitor or in the Timeline.

Bug Number: MCDEV-10818. Floating a bin might have resulted in the bin resizing too small.

Bug Number: MCDEV-10880. When creating a Volume Bin, “Export Folder” and “Set
location” text does not display correctly if you are working in a Russian locale.

Bug Number: MCDEV-10918. Mapping “Set Bin Display” to a letter on the keyboard did not
work.

Bug Number: MCDEV-10934. Typing the first letter of setting displayed the setting at the
bottom of the window rather than in the middle of the window.

Bug Number: MCDEV-10995. When in Frame view, if you dragged a clip to the Source
Monitor, the clip would load into the source monitor, but the clip’s thumbnail was moved to an
unintended location within the bin.

Bug Number: MCDEV-11131. In some instances, effects with graphic backgrounds did not
draw correctly in the track effect dialog.

Bug Number: MCDEV-11145. An Interlaced Roll/Crawl motion effect created with Titler +
appeared as a frame motion rather than field motion effect.

Bug Number: MCDEV-11191. Double clicking to float an existing bin always stacked the bin
in same position/size and did not retain its last known state.

Bug Number: MCDEV-11231. You might have experienced an occasional crash on exit with
AJA 4K hardware attached. You must update to AJA Desktop software v15.2 to see this fix.

Bug Number: MCDEV-11245. The File Cache tab in Media Cache Settings window was cut off
and difficult to activate.

Bug Number: MCDEV-11299. The font appeared bold in the Name fields for the Source and
Record side of the Composer window.

Bug Number: MCDEV-11317. Titler + titles appeared in the bin without an icon.
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Fixed in Media Composer v2019.7

Bug Number: MCDEV-11429. The Name column did not appear as the first column in the
Media Tool.

Bug Number: MCDEV-11442. (Bin Frame view) Clicking near edge of a selected item in the
bin while in text-edit mode deselected the item.

Bug Number: MCDEV-11453. The Audio Clip Gain window did not remain open when you
tried to enter a value from the keyboard or if you tried to move the slider up with the mouse.

Bug Number: MCDEV-11491. Pressing and holding the ALT key while dragging a number of
clips onto the Record monitor did not create a sequence with the clips in the order they were
sorted in the bin.

Bug Number: MCDEV-11492. If you selected a dropdown menu in the Inspector Tool and then
clicked on another window, focus remained on the Inspector Tool.

Bug Number: MCDEV-11530. Double clicking a clip in Bin Frame view to load in the
Composer monitor did not leave focus on the Composer monitor.

Bug Number: MCDEV-11534. The Lock/Unlock Bin options were missing from the Bin
Container sidebar context and Fast menus.

Bug Number: MCDEV-11546. You might have received a “Crumb not found” error when
deleting markers in the Source monitor.

Bug Number: MCDEV-11550. Perf information was missing in the Setting format pane of a
film project.

Bug Number: MCDEV-11562. Tab and Shift+Tab did not allow you to move to the next or
previous column in Bin Text View.

Bug Number: MCDEV-11568. With the Interface Brightness set to dark, track numbers were
too light when you expanded the Audio Mixer Tool.

Bug Number: MCDEV-11569. You might have received a “PMM_SYNC_FAILURE” error
when performing an Audio mixdown of a sequence with sub-clips and sample slip.



Limitations

Limitations

>

Bug Number: MCCET-3110. When in Text View, you no longer have the option in the Bin
Window to lock columns during scrolling left and right.

Bug Number: MCDEV-11430. Media Tool ignores the “Current project” filtering option and
lists media files that are not associated with the current project.

Bug Number: . If you launch a project and receive an “Enable 3rd Party Emulation” warning,
even if you select Enable in the warning dialog, you should also perform the following: Select
File > Settings and click the Project tab. Click General Settings and select “Enable Bin Sharing
on 3rd party storage emulating Avid NEXIS/ISIS.”

Bug Number: MCDEV-11197. In some instances, the Interleave option might not appear in the
Export As dialog box. If you are performing an Export using the Avid Media Processor, the
Interleave option should appear when you choose Stereo, 5:1, or 7.1 Audio.

Workaround: If it does not appear, briefly toggle back to the Mono setting, then toggle to
Stereo Mix once again. Doing so should reveal the Interleave option.

Bug Number: MCDEV-8641. (AMD Graphics). Systems with AMD graphics cards might
display tearing when performing Full Screen playback.

Bug Number: MCDEV-9460. Windows 7 systems with Nvidia Maxwell or Nvidia Pascal cards
might experience playback issues that could result in “Play Consumer timeout” errors.

Workaround: Select “Disable GPU Effects” in the Render Settings dialog box.

Bug Number: MCDEV-9269. (Media Composer | Cloud) After performing a remote download
operation on a sequence containing AVC-I 100 remote media, the downloaded media appears as
XAVC-1100.

Workaround: Download the entire master clips.

Bug Number: (Mac). You may occasionally see the menu bar flash followed by a brief beach
ball. To fix this, deactivate “Displays have separate spaces” under System Preferences > Mission
Control settings.

Bug Number: MCDEV-9011. Intermittently, when working with the XDCAM Nablet Plug-in,
you might see “Failed to get the sample position from the AMA Plug-in” errors if you have
waveforms enabled in the Timeline.



Before Installing the Editing Application

Bug Number: COGS-2560. While working in the Script Window, text operations
(cut/copy/paste/delete/editing) can only be done in edit mode. See “Editing a Script” in the Help.

Bug Number: MCDEV-5650. When working with Panasonic LongG media, you might receive
an “SFPlayConsumer Timeout” error if audio waveforms are enabled.

Workaround: Turn off audio waveforms.

Bug Number: MCDEV-5385. MultiCam editing with Panasonic LongG media is not supported
with this release.

Before Installing the Editing Application

m

Media Composer | Enterprise and Media Composer | Distributed Processing

If you are working with Media Composer | Enterprise or Media Composer | Distributed
Processing, please refer to the “Installation Prerequisites” section in the Media Composer |
Enterprise Administration Guide and Media Composer | Distributed Processing Administration
Guide to make sure you have compatible Avid MediaCentral Cloud UX Platform ISO and Avid
MediaCentral Cloud UX Feature Pack ISO versions.

Avid DX Driver Separate Installer

The Avid DX Driver is not automatically installed when you install the editing application. If
you need to install the Avid DX Driver to work with your Avid IO device, you can install it
separately.

The installer is located:

*  (Mac) /Applications/Utilities/Avid Utilities

*  (Windows) Program Files\Avid\Utilities\DXDrivers

For Windows systems, there is a Win7 driver and a Winl0 driver in the Utilities folder. The Win7
driver works for both Windows 7 and Windows 8 systems.

Before Installing the Editing Application in an Avid Interplay Environment

Please note the following before you install the editing application in an Avid Interplay or
Avid MediaCentral environment.

Carefully read through the “Avid Editor Compatibility with Interplay Releases” guide (found in
the following link) before upgrading. It might be necessary to also upgrade the Interplay
components on the editing client.
http://avid.force.com/pkb/articles/en_US/compatibility/Avid-Video-Compatibility-Charts
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Before Installing the Editing Application

Upgrading to Mac OS v10.11.x

(Mac) If you upgrade to Mac OS 10.11.x, you must uninstall Media Composer. Reinstall Media
Composer after you perform the OS upgrade. If you use Avid Artist DNxIO, you must also
uninstall the Desktop Video software and reinstall it after the OS upgrade.

Installation Information

Read through the Installation Guide for Avid Editing Applications. This document is available on
the Knowledge Base.

If you are upgrading from v7.x to v8.x, you must uninstall the Avid Transcode Service and the
Avid Editing application. Beginning with version 8.0 of the editing application, the Transcode
Service is included as part of the editing application and is no longer a separate program. When
you uninstall Media Composer v8.0, a separate uninstall of Transcode service is no longer
necessary.

Buffer Error Message

The editing application requires a minimum of 8GB RAM. If you try to install the editing
application on a system with less than 8GB RAM, you will receive a buffer error and installation
will not proceed.

Sentinel Error Message

(MCDEV-2394) On a Windows 7 system, if a “Failed to add Sentinel64.cat file.” error appears
during the installation, you can safely click OK to continue with the installation. Dongle
activation will work properly.

Download Note

To avoid “File Path too long” or a “File cannot be copied” warning while unzipping the
downloaded installer, try placing the installer .zip on the root level of your C:\ drive and unzip it
from that location.

User Right to Raise Thread Priority

(Windows) Note for Domain Administrators: If your editing systems are part of a domain, you
must give the user the right to “Increase Scheduling Priority.” This must be done within the
Domain Group Policy on the domain controller by giving the right explicitly to the user or giving
the right to a group and adding the user to that group. You will not be able to launch as a regular
user if this is not set properly.

If you are part of a domain, a Domain Administrator should install and perform the first launch
of the editing application.

11



After Installing the Editing Application

Install as Administrator

You need to first install and launch the editing application as an Administrator. If you are in a
Shared Storage environment, mount your workspaces as an Administrator. You may then log off
and log back in as a Standard user, if necessary.

After Installing the Editing Application

AMA Plug-Ins

You cannot install the AMA Plug-ins while the editing application background services are
running. Make sure you Stop the services before installing the AMA Plug-Ins. The stop/start
background services icon is on the menu bar (Macintosh) or taskbar (Windows). Once you install
the new AMA plug-in, restart the services. See “Starting and Stopping Avid Background
Services” in the Help.

Notes on Software Licensing

If You Upgrade Your Operating System

If you need to upgrade your operating system after you install your Avid editing application, first
deactivate your software. After you upgrade your operating system and, if required, reinstall
your application, you can reactivate your software. For information on activating and
deactivating your software license, see the Installation Guide for Avid Editing Applications.

Minimum RAM Recommendation

For this release Avid recommends 16 GB minimum, 32 GB recommended. Some features might
require more RAM and specific hardware. See “Feature Performance” on page 29 for more info.

Qualified Hardware and Operating Systems

Some features are processor-intensive and require specific hardware. See “Feature Performance”
on page 29 for more info.

The following tables provide the information on qualified Windows and Macintosh hardware.

For 3rd-Party Open 10 hardware qualification refer to the manufacturer’s documentation. See the
Open 10 Frequently Asked Questions document on the Knowledge Base:
http://avid.force.com/pkb/articles/en_US/faq/en422991
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Qualified Hardware and Operating Systems

The following lists the qualified Operating Systems. Depending upon your hardware the
qualified Operating Systems are:

*  Windows v7 64-bit SP1(Professional) and Windows v8.1 (Professional and Enterprise),
Windows v10 64-bit v1803 or later (Professional and Enterprise).

e Macintosh v10.12.6, 10.13.6, 10.14.5

With the release of Mac OS v10.13.x and higher, Apple requires manual approval of loading
Kernel Extensions (KEXTs). (For example Avid Nitris DX, BlackMagic, and AJA IO devices
install Kernel Extensions.) At installation time, you should get a dialog saying that the KEXT
was not loaded. You must go the “Security & Privacy” system preference and manually approve
the KEXT. Keep the Security & Privacy pane open after you install the I/O device drivers so that

you will see the notice that the driver has been blocked and press the “allow” button within 30
minutes of installing or the driver will be permanently blocked.

Qualified Workstations and Laptops

The following tables list the qualified workstations and laptops for Media Composer editing
applications.

Qualified PC Workstations with Avid Media Composer
The following PC Workstations are qualified with Avid Media Composer.

Avid Artist DNxIV requires a Thunderbolt 2 or 3 card. See details here.

Qualified PC Hardware Graphics Card  Supported with
HP Z2 G4 3.0 Ghz or higher six core i7/Xeon E3 Nvidia P620, Avid Artist DNXIO
Tower or SFF P1000, P2000 AMD Avid Artist DNXIQ
8 to 64 GB DDR4-2666 memory WX7100 Avid Artist DNxIV
Avid Artist DNXID

Avid Artist DNxIP

Dell 3630 3.0 Ghz or higher six core i7/Xeon E3  Nvidia P1000, Avid Artist DNxIO
Tower 8 to 64 GB DDR4-2666 memory P2000 AMD Avid Artist DNxIQ
WX7100 Avid Artist DNxIV

Avid Artist DNxXID

Avid Artist DNxIP
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Qualified PC Hardware

Qualified Hardware and Operating Systems

Graphics Card

Supported with

Dell 3430 3.0 Ghz or higher six core i7/Xeon E3
SFF 8 to 64 GB DDR4-2666 memory

Dell 3930 3.0 Ghz or higher six core i7/Xeon E3
1U Rack 8 to 64 GB DDR4-2666 memory
Thunderbolt adapter not supported

Lenovo P330 3.0 Ghz or higher six core i7/Xeon
E3 Tower or SFF 8§ to 64 GB DDR4-2666
memory

Lenovo P330 Tiny 2.9 Ghz six core i7-8700T
8 to 64 GB DDR4-2666 memory — 1 option slot
— TB or discrete graphics

HP Z2 G4 Mini 3.0 Ghz or higher six core
i7/Xeon E3

8 to 32 GB 2666Mhz DDR4 Memory.
Performance model only Thunderbolt option.

HP Z8 G4 Dual [8 - 24 core 2.1 Ghz or higher]
scalable

64-128 GB DDR4-2666 memory, Tower

HP Z6 G4 Dual [8 -24 core 2.1 Ghz or higher]
Intel Scalable Processors
64 to 192GB DDR4-2666 memory

14

Nvidia P1000
AMD WX4100

Nvidia P1000,
P2000 AMD
WX7100

Nvidia P600 P1000
P2000

Nvidia P600

Nvidia P600, P1000

Nvidia P4000,
P5000, P6000

AMD WX7100

Nvidia P4000,
P5000,
AMDWX7100

Avid Artist DNXIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNXID
Avid Artist DNxIP

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP



Qualified PC Hardware

Qualified Hardware and Operating Systems

Graphics Card

Supported with

HP 74 G4 6 - 10 core or 18 core 3.3 Ghz or
higher processor

32-128 GB DDR4-2666 memory, Tower

Dell 7920 Dual (8-24 core 2.1 GHz or higher)
Intel Scalable Processors Tower
64 to 128 GB DDR4-2666 memory

Dell R7920 Dual (8-24 core 2.1 GHz or higher)
Intel Scalable Processors Rack

64 to 128 GB DDR4-2666 memory
Thunderbolt adapter not supported in Rack 7920

Dell 7820 Dual (8-24 core 2.1 GHz or higher)
Intel Scalable Processors
64 to 128 GB DDR4-2666 memory

Dell 5820 6, 8 or 10 core 3.3 Ghz or higher
Intel W-Processors
32 to 128 GB DDR4-2666 memory

Lenovo P920 Dual [8 -28 core 2.1 Ghz or
higher] Intel Scalable Processors
64 to 192 GB DDR4-2666 memory

HP Z1 G3 All-in-one 3 3.4 Ghz or higher quad
core i7/Xeon E3
8 or 16 GB DDR3-1600 Memory

HP Z240 3.0 Ghz or higher quad core i7/Xeon
E3 8 to 64 GB DDR4-2400 memory Tower or
SFF
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Nvidia P2000,
P4000

AMD
WX5100,WX7100

Nvidia P4000
P5000 P6000
AMD WX7100

Nvidia P4000
P5000 P6000
AMD WX7100

Nvidia P4000
P5000 AMD
WX7100

Nvidia P600, P1000
P2000

Nvidia P4000
P5000, P6000

Nvidia M1000M,
M2000M

Nvidia K1200
(SFF), P2000
(Tower)

Intel P630

Avid Artist DNXIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNXID
Avid Artist DNxIP

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP

Software Only



Qualified Hardware and Operating Systems

Qualified PC Hardware Graphics Card  Supported with
HP Z2 Mini 3.0 Ghz or higher quad core Nvidia M620, Software Only
i7/Xeon E3 8 to 32 GB 2400Mhz DDR4 HDS530, HD630
Memory, USB-C
Dell 3620 3.0 Ghz or higher quad core i7/Xeon Nvidia M2000, Software Only
E3 8/16/32 GB DDR4-2400 memory Tower M4000
Intel P630
Dell 3420 3.0 Ghz or higher quad core i7/Xeon Nvidia K620, Software Only
E3 8/16/32 GB DDR4-2400 memory SFF K1200
Intel P630
Dell 5720 AIO 3.3 Ghz or higher quad core AMD WX4150 Mojo DX
i7/Xeon E3 3840x2160 - 8 to 64 GB 2400Mhz Avid Artist DNxIO
DDR4 Memory, thunderbolt 3/USB-C Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP
Lenovo P720 Dual [8 -28 core 2.1 Ghz or NvidiaP2000, Avid Artist DNxIO
higher] Intel Scalable Processors P4000 P5000 Avid Artist DNxIQ
64 to 192 GB DDR4-2666 memory Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP
Lenovo P520/P520C 6, 8, 10 or 18core 2.3 Ghz Nvidia P1000, Avid Artist DNxIO
or higher] Intel W-Processors P2000 P4000 Avid Artist DNxIQ
32 to 128 GB DDR4-2666 memory Avid Artist DNxID
Avid Artist DNxIP
Lenovo P320 3.0 Ghz or higher quad core Nvidia P600, Software Only
i7/Xeon E3 8/16/32 GB DDR4-2400 memory ~ P1000,
Tower or SFF P2000(Tower)
Intel P630
Lenovo P320 Tiny 2.9 GHz quad core i7-7700T Nvidia P600 Software Only
HP Z840 Dual [8 - 16 core 2.1 Ghz or higher] = Nvidia P4000, Nitris DX
Intel V4 32/64 GB DDR4 2400 memory P5000, P6000, Mojo DX
M4000, M5000, Avid Artist DNxIO
M6000 Avid Artist DNxIQ
AMD W7100, i"?g ﬁ“?“ ggxg
WX7100 vid Artist X
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Qualified PC Hardware

Qualified Hardware and Operating Systems

Graphics Card

Supported with

HP Z640 Dual 10, 12, 16 core 2.1 Ghz or
higher] Intel V4 32/64 GB DDR4-2400 memory

Dell 7910 Dual [8 - 16 core 2.1 Ghz or higher]
Intel V4 32/64 GB DDR4-2400 memory

Dell R7910 Dual [8 - 16 core 2.1 Ghz or higher]
Intel V4 32/64 GB DDR4-2400 memory

Dell 7810 Dual [8-16 core 2.1 Ghz or higher]
Intel V4 32/64 GB DDR4-2400 memory

Dell 5810 [6 or 8 core 3.0 Ghz or higher] Intel
V4 16/32/64 GB DDR4- 2400 memory

Lenovo P910 Dual [8 - 16 core 2.1 Ghz or

Nvidia P4000,
P5000, P6000
M2000, M4000
M5000, M6000

AMDW5100,
W7100, W8100

Nvidia M4000,
M5000, M6000

AMD W7100,
W8100

Nvidia M4000,
M5000, M6000

AMD W7100,
W8100

Nvidia M2000,
M4000, M5000

AMD W5100W,
W7100, W8100

Nvidia M2000
AMD W5100

Nvidia M4000,

higher] Intel V4 32/64 GB DDR4-2400 memory MS5000, M6000
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Nitris DX
Mojo DX
Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxIP

Nitris DX
Mojo DX
Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxIP

Mojo DX
Avid Artist DNxIO
Avid Artist DNxIQ

Nitris DX
Mojo DX
Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxIP

Nitris DX
Mojo DX
Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxIP

Nitris DX
Mojo DX
Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxIP



Qualified PC Hardware

Qualified Hardware and Operating Systems

Graphics Card

Supported with

Lenovo P710 Dual [8 - 16 core 2.1 Ghz or
higher] Intel V4 32/64 GB DDR4-2400 memory

HP Z440 [6 or 8 core 3.0 Ghz or higher] Intel
V4 16/32/64 GB DDR4- 2400 memory

Lenovo P510 6 or § core 3.0 Ghz or higher Intel
V4 16/32/64 GB DDR4- 2400 memory

Lenovo P410 6 or 8 core 3.0 Ghz or higher Intel
V4 16/32/64 GB DDR4- 2400 memory

HP Z840 Dual 8, 10 or 12 core Intel V3 2.3 Ghz
or higher Onboard NIC supported for ISIS 32 or
64 GB DDR4- 2133 memory

HP Z640 Dual 8, 10 or 12 core Intel V3 2.3 Ghz
or higher 32/64 GB DDR4-2133 Memory
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Nvidia M2000,
M4000, M5000

Nvidia P2000,
M2000

AMD W5100

Nvidia M2000,
K1200

Nvidia P2000,
P1000
M2000, K1200

Nvidia K4200,
K5200, M4000,
M5000, M6000

AMD W7100,
W8100

Nvidia K2200,
K4200, K5200,
M4000, M5000

AMD, W5100,
W7100, W8100

Nitris DX
Mojo DX
Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxIP

Nitris DX
Mojo DX
Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxIP

Nitris DX
Mojo DX
Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxIP

Nitris DX
Mojo DX
Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxIP

Nitris DX
Mojo DX
Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxIP

Nitris DX
Mojo DX
Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxIP



Qualified PC Hardware

Qualified Hardware and Operating Systems

Graphics Card

Supported with

Dell R7910 Dual 8,10 or 12 Core Intel V3
2.3 Ghz or higher Onboard NIC supported for
ISIS 32 or 64 GB DDR4- 2133 memory

Dell 7910 Dual 8, 10 or 12 core Intel V3 2.3 Ghz
or higher - Onboard NIC supported for ISIS 32
or 64 GB DDR4- 2133 memory

Dell 7810 Dual 8, 10 or 12 core Intel V3 2.3 Ghz
or higher - Onboard NIC supported for ISIS 32
or 64 GB DDR4- 2133 memory

Lenovo P900 Dual 8, 10 or 12 core Intel V3 2.3
Ghz or higher - Onboard NIC supported for ISIS
32 or 64 GB DDR4- 2133 memory

Lenovo P700 Dual 8, 10 or 12 core Intel V3
2.3 Ghz or higher - Onboard NIC supported for
ISIS

32 or 64 GB DDR4- 2133 memory

HP Z240 Tower and SFF (Small Form Factor)
Quad Xeon E3- 1245V5 3.5 Ghz

Onboard NIC supported for ISIS

8/16/32 GB DDR4- 2133 Memory

Lenovo P310 Tower and SFF (Small Form
Factor) Quad Xeon E3- 1245V5 3.5 Ghz
Onboard NIC supported for ISIS

8/16/32 GB DDR4- 2133 Memory
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Nvidia K4200,
K5200, M4000,
M5000, M6000

AMD W7100,
Wg100

Nvidia K4200,
K5200, M4000,
M5000, M6000

AMD W7100,
W8100

Nvidia K2200,
K4200, K5200,
M4000, M5000

AMD W5100,
W7100, W8100

Nvidia K4200,
K5200, M4000,
M5000, M6000

Nvidia, K2200
K4200, K5200,
M4000, M5000

Nvidia K620,
K1200

K2200, HD530

Nvidia K620,
K1200

K2200
HD530

Mojo DX

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxIP

Nitris DX
Mojo DX
Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxXIP

Nitris DX
Mojo DX
Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxIP

Nitris DX
Mojo DX
Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxIP

Nitris DX
Mojo DX
Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxIP

Software Only

Software Only



Qualified Hardware and Operating Systems

Qualified PC Hardware Graphics Card

Supported with

Dell 3620 quad Xeon E3-1245V5 3.5 Ghz Nvidia K620,
Onboard NIC supported for ISIS 8/16/32 GB K2200
DDR4- 2133 Memory HD530

Dell 3420 SFF (Small Form Factor) Quad Xeon Nvidia K620,
E3-1245V5 3.5 Ghz K1200
Onboard NIC supported for ISIS HD530
8/16/32 GB DDR4- 2133 Memory

Dell 5810 6-core or 8 core Intel V3 3.0 Ghz or  Nvidia K2200
higher

AMD W5100
Onboard NIC supported for ISIS
16 or 32 GB DDR4- 2133 memory

Lenovo P500 6-core or 8 core Intel V3 3.0 Ghz Nvidia K2200
or higher

Onboard NIC supported for ISIS

16 or 32 GB DDR4- 2133 memory

Lenovo P300 Tower and SFF (Small Form Intel HD 4600
Factor) Quad-Core E3- 1246v3 3.5 Ghz CPU -1

N K K62
8 or 16 GB DDR3-1600 Memory vidia K600, K620

HP Z1 G2 All-in-one E3- 1245V3 3.4 Ghz CPU Intel HD 4600

8 or 16 GB DDR3-1600 Memory Nvidia K2100M,
K3100M, K4100M

Lenovo ThinkCentre Edge 93Z i17-4770S quad  Intel HD 4600

core 3.1 Ghz
8 or 16 GB DDR3-1600 memory

Software Only

Software Only

Nitris DX
Mojo DX
Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxIP

Nitris DX
Mojo DX
Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxIP

Software Only

Mojo DX

Software Only

Qualified PC Notebooks for Avid Media Composer

The following PC Notebooks are qualified with Avid Media Composer. The following applies to

the editing system when running on a laptop:

*  DNxHD capture is only supported on Mojo DX on a Quad core system with hyperthreading

enabled. Nitris DX is not supported on laptops.

*  Capture of 10 bit video for example, DNxHD 185x, is not supported on Mojo DX.
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Qualified PC Notebooks

Qualified Hardware and Operating Systems

Graphics Cards Supported With

HP Zbook Studio G5 and Studio X360 G5 2.6  Nvidia P1000
Ghz or higher six core i7/Xeon E3 Ultrabook

8 to 32 GB 2667Mhz DDR4 Memory

Dream Color option

HP Thunderbolt dock G2

Dell 5530 15" 2.6Ghz or higher 6 core i7/Xeon NvidiaP1000

E3
Thin and light

8 to 32 GB 2667Mhz DDR4 Memory

P2000

USB 3.0 to Ethernet required for Avid NEXIS

Connectivity

Lenovo P1 157 2.6 Ghz or higher six core
17/Xeon E3 Thin and Light
8 to 64 GB 2667Mhz DDR4 Memory

Nvidia P1000

HP Zbook 17" G5 2.6 Ghz or higher six core ~ Nvidia P3200,

i7/Xeon E3

P4200, P5200
AMD WX4170

Dell 7730 17" 2.6Ghz or higher 6 core i7/Xeon NvidiaP3200

E3

8 to 64 GB 2667Mhz DDR4 Memory

P4200 P5200
AMD WX4170

Lenovo P72 2.6 Ghz or higher six core i7/Xeon Nvidia P3200,

E3

8 to 64 GB 2667Mhz DDR4 Memory

P4200, P5200
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Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP
Mojo DX

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP
Mojo DX

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP
Mojo DX

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNXIP
Mojo DX

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP
Mojo DX

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP
Mojo DX



Qualified Hardware and Operating Systems

Qualified PC Notebooks Graphics Cards Supported With
HP Zbook 15" G5 2.6 Ghz or higher six core ~ Nvidia P1000, Avid Artist DNxIO
i7/Xeon E3 P2000 Avid Artist DNxIQ
8 to 64 GB 2667Mhz DDR4 Memory AMD WX4150 Av%d Art%st DNxIV
Dreamcolor option Avid Artist DNxID
Avid Artist DNxIP

Mojo DX
HP Zbook 15V G5 2.6 Ghz or higher six core  Nvidia P1000 Avid Artist DNxIO
i7/Xeon E3 Avid Artist DNxIQ
HP Thunderbolt dock G2 Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP

Mojo DX
Dell 7530 15" 2.6Ghz or higher 6 core i7/Xeon NvidiaP1000 Avid Artist DNxIO
E3 P2000 Avid Artist DNXIQ
8 to 64 GB 2667Mhz DDR4 Memory AMD WX4150 Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP

Mojo DX
Dell 3530 15" 2.6Ghz or higher 6 core i7/Xeon NvidiaP600 Avid Artist DNxIO
E3 Avid Artist DNxIQ
8 to 32 GB 2667Mhz DDR4 Memory Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNXIP

Mojo DX
Lenovo P52 2.6 Ghz or higher six core i7/Xeon Nvidia P1000, Avid Artist DNxIO
E3 P2000 Avid Artist DNxIQ
8 to 64 GB 2667Mhz DDR4 Memory Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP

Mojo DX
HP Zbook 17" G4 2.8 Ghz or higher quad core Nvidia Avid Artist DNxIO
i7/Xeon E3 P3000 Avid Artist DNxIQ
HP Thunderbolt dock G2 P4000 Avid Artist DNxIV
P5000 Avid Artist DNxID
AMD Avid Artist DNxIP

WX4170 Mojo DX
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Qualified Hardware and Operating Systems

Qualified PC Notebooks Graphics Cards Supported With
HP Zbook 15" G4 2.8 Ghz or higher quad core Nvidia Avid Artist DNxIO
i7/Xeon E3 M620 Avid Artist DNxIQ
HP Thunderbolt dock G2 M1200 Avid Artist DNxIV
M2200 Avid Artist DNXID
AMD WX4150 Avid Artist DNXIP

Mojo DX
HP Zbook Studio Ultrabook G4 2.8 Ghz or Nvidia Avid Artist DNxIO
higher quad core i7/Xeon E3 M1200 Avid Artist DNxIQ
HP Thunderbolt dock G2 Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP

Mojo DX
Dell 7720 17" 2.6 Ghz or higher quad core Nvidia P3000, Avid Artist DNxIO
i7/Xeon E3 1920x1080 or 3840x2160 - 8 to P4000, P5000 Avid Artist DNXIQ
64 GB 2400Mhz DDR4 Memory, thunderbolt 3 AMD Radeon Av%d Art%st DNxIV
WX4150, Wx7100 AVid Artist DNxID
Avid Artist DNxIP

Mojo DX

Dell 7520 15" 2.6 Ghz or higher quad core Nvidia M1200, Avid Artist DNxIO
i7/Xeon E3 1920x1080 or 3840x2160 - 8 to M2200 Avid Artist DNXIQ
64 GB 2400Mhz DDR4 Memory, thunderbolt 3 AMD Radeon Avid Art%st DNxIV

WX4130, Wx4150 AVid Artist DNXID
Avid Artist DNxIP
Mojo DX

Dell 5520 15" 2.8 Ghz or higher quad core Nvidia M1200 Avid Artist DNxIO

i7/Xeon E3 1920x1080 or 3840x2160 - 8 to Avid Artist DNxIQ

32 GB 2400Mhz DDR4 Memory Thunderbolt 3 Avid Artist DNxIV
Avid Artist DNXID
Avid Artist DNxIP
Mojo DX

Dell 3520 15" 2.8 Ghz or higher quad core Nvidia Avid Artist DNxIO
i7/Xeon E3 1920x1080 - 8 to 32 GB 2400Mhz M620 Avid Artist DNxIQ
DDR4 Memory - Thunderbolt 3 Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP

Mojo DX
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Qualified Hardware and Operating Systems

Qualified PC Notebooks Graphics Cards Supported With
Lenovo P51 2.6 Ghz or higher quad core Nvidia M1200, Avid Artist DNxIO
i7/Xeon E3 M2200 Avid Artist DNxIQ
8 to 64 GB 2400Mhz DDR4 Memory Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP
Mojo DX
Lenovo P71 2.6 Ghz or higher quad core Nvidia P3000, Avid Artist DNxIO
i7/Xeon E3 P4000, P5000 Avid Artist DNXIQ
8 to 64 GB 2400Mhz DDR4 Memory Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP
Mojo DX
HP Zbook Studio Ultrabook 2.6 Ghz or higher Nvidia M1000M Avid Artist DNxIO
quad core i7/Xeon E3 Avid Artist DNxIQ
8 t0 32 GB 2133Mhz DDR4 Avid Artist DNXIV
Avid Artist DNxID
Avid Artist DNxIP
Mojo DX

HP Zbook 15" G3 2.6 Ghz or higher Quad core Nvidia M1000M,  Avid Artist DNXIO

i7/Xeon E3 1920x1080 or 3840x2160- § to 64 Avid Artist DNxIQ
M2000M, M600M

GB 2133Mhz DDR4 Memory, thunderbolt 3 ’ Avid Artist DNxIV
AMD, W5170M  Avid Artist DNxID
Intel HD 530, P530, Avid Artist DNXIP

HP Zbook 17" G3 2.6Ghz or higher quad core  Nvidia M3000M,  Avid Artist DNXIO
M4000M, M5000M  Avid Artist DNxIQ

17/Xeon E3
Avid Artist DNxIV
AMD 150M
W6I50 Avid Artist DNxID
Intel HD 530, P530, Avid Artist DNxIP
P580 Mojo DX

Dell 7710 17" 2.7 Ghz quad core i7 or 2.9 Ghz Nvidia M3000M,  Avid Artist DNxIO
Xeon E3 1920x1080 or 3840x2160 - 8/16/32  M4000M, M5000M Avid Artist DNxIQ
GB 2133Mhz DDR4L Memory Avid Artist DNxIV
AMD W7170M
W70 Avid Artist DNxID
Avid Artist DNxIP
Mojo DX
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Qualified Hardware and Operating Systems

Qualified PC Notebooks Graphics Cards Supported With
Dell 7510 15" 2.5 Ghz and higher quad core i7 Nvidia M1000M,  Avid Artist DNxIO
1920x1080 or 3200x1800 - 8/16/32 GB M2000M Avid Artist DNxIQ
2133Mhz DDR4L Memory AMD W5170M Av%d Art%st DNxIV
Avid Artist DNxID
Avid Artist DNXIP
Mojo DX
Dell 5510 15" 2.3 Ghz and higher quad core i7 Nvidia M1000M Avid Artist DNxIO
1920x1080 or 3840x2160 - 8/16 GB 2133Mhz Avid Artist DNXIQ
DDR4L Memory USB-C Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP
Mojo DX
Dell 3510 15" 2.3 Ghz and higher quad core i7 AMD W5130M Avid Artist DNxIO
1920x1080 - 8/16 GB 2133Mhz DDR4L Avid Artist DNXIQ
Memory Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP
Mojo DX
Lenovo P70 2.6 Ghz or higher quad core Nvidia M3000M,  Avid Artist DNxIO
i7/Xeon E3 M4000M, M5000M Avid Artist DNxIQ
1920x1080 or 3840x2160 - 8 to 64 GB Avid Artist DNXIV
2133Mhz DDR4, Memory, thunderbolt 3 Avid Artist DNxID
Mojo DX
Lenovo P50 2.6 Ghz or higher quad core Nvidia M1000M,  Avid Artist DNxIO
i7/Xeon E3 1920x1080 or 3840x2160 - 8 to 64 M2000M Avid Artist DNXIQ
GB 2133Mhz DDR4 Memory, thunderbolt 3 Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP
Mojo DX

HP Zbook 17" G2 - 2.5 Ghz and higher quad ~ Nvidia K3100M Avid Artist DNxIO

core i7 1920x1080 - 8/16/32 GB 1600Mhz K4100M, K2200M  Avid Artist DNxIQ

DDR3 Memory thunderbolt Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP
Mojo DX
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Qualified PC Notebooks

Qualified Hardware and Operating Systems

Graphics Cards

Supported With

HP Zbook 15" G2 - 2.5 Ghz and higher quad ~ Nvidia K1100M,  Avid Artist DNXIO

core 17 1920x1080 or 3200x1800 screen K2100M Avid Artist DNxIQ

resolution 8/16/32 GB 1600Mhz DDR3L Avid Artist DNXIV

Memory Thunderbolt Avid Artist DNxID
Avid Artist DNxIP
Mojo DX

Dell M6800 17" 2.5 Ghz and higher quad core  Nvidia K2200M,  Software Only

17 1920x1080 - 8/16/32 GB 1600Mhz DDR3
Memory

K3100M, K4100M
K5100M

Mojo DX

Dell M4800 15" 2.5 Ghz and higher quad core Nvidia K1100M,  Software Only

i7 1920x1080 or 3200x1800 - 8/16/32 GB K2100M Mojo DX

1600Mhz DDR3 Memory

Dell M3800 15" 2.3 Ghz and higher quad core  Nvidia K1100M Avid Artist DNxIO

17 1920x1080 8/16/32 GB 1600Mhz DDR3 Avid Artist DNxIQ

Memory Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP
Mojo DX

Lenovo W541 15" 2.5 Ghz and higher quad Nvidia K1100M,  Avid Artist DNxIO

core i7 15" 1920x1080 2880x1620 - 8/16/32 K2100M Avid Artist DNXIQ

GB 1600Mhz DDR3 Memory Thunderbolt Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP
Mojo DX

Qualified Macintosh Workstations for Avid Media Composer
The following Macintosh Workstations are qualified with the Avid Media Composer.

Avid Artist DNxIV requires a Thunderbolt 2 or 3 card. See details here.

Qualified Macintosh Hardware Graphics Cards Supported With

iMac Retina 5K 27” 3.6 GHz 8-core Intel i9 AMD Radeon Pro Avid Artist DNxIO
16 to 64GB 2666MHz DDR4 575x, 580x, Vega 48  Avid Artist DNxIQ
Avid Artist DNxIV
March 2019 Avid Artist DNxID
Avid Artist DNxIP
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http://avid.force.com/pkb/articles/en_US/Compatibility/DX-DNxIO-connection-chart

Qualified Macintosh Hardware

Qualified Hardware and Operating Systems

Graphics Cards

Supported With

iMac Retina 4K 21.5” 3.2 GHz 6-core Intel i7 AMD Radeon Pro Avid Artist DNxIO
16 to 32 GB 2666 MH DDR4 560x Vega 20 Avid Artist DNXIQ
Avid Artist DNxIV
March 2019 Avid Artist DNxID
Avid Artist DNxIP
Mac mini 3.2 Ghz 6- core Intel i7 Intel UHD 630 Avid Artist DNxIO
8 to 64 GB 2666 Mhz DDR4 Memory Avid Artist DNxIQ
Avid Artist DNxIV
Late 201
ate 2018 Avid Artist DNxID
Avid Artist DNxIP
iMac Pro 5K 27" 3.2 Ghz i7 8 core Radeon Pro Vega 56, Avid Artist DNXIO
3.0 Ghz i7 10 core 64 Avid Artist DNxIQ
2.5 Ghz 17 14 core Avid Artist DNxIV
2.3 Ghzi7 18 core Avid Artist DNxID
Late 2017 - 32 to 128GB 2666 Mhz DDR4 Avid Artist DNxIP
Mojo DX

NOTE: 10Gb Ethernect requires Avid NEXIS
Pro client v2018.3.

iMac Retina 5K 27" 4.2 Ghz i7 Quad core ~ Radeon Pro 570, 575, Avid Artist DNxIO

Mid 2017 - 8 to 64 GB 2400 Mhz DDR4 %0 Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP
Mojo DX

iMac Retina 4K 21.5" 3.6 Ghz i7 Quad core Radeon Pro 555, 560 Avid Artist DNxIO

Mid 2017 - 8 to 32 GB 2400Mhz DDR4 Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNXID
Avid Artist DNXIP
Mojo DX

iMac Retina 5K 27" 4.0 Ghz i7 Quad core Radeon M390, M395, Avid Artist DNxIO

Late 2015 - 8/16/32 GB 1867Mhz DDR3 M395X Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP
Mojo DX

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxIP
Mojo DX

iMac Retina 4K 21.5" 3.3 Ghz i7 Quad core Intel Iris Pro 6200
Late 2015 - 8/16/32 GB 1867Mhz DDR3
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Qualified Macintosh Hardware

Qualified Hardware and Operating Systems

Graphics Cards

Supported With

iMac Retina 5K 27" 4.0 Ghz i7 Quad core
Late 2014 - 8/16/32 GB 1600Mhz DDR3

Mac Pro 6 core 3.5 Ghz, 8 core 3.0 Ghz, 12
core 2.7 (Late 2013) 16/32 GB 1866Mhz
DDR3 Memory Thunderbolt - no PCI-e slots

Radeon M290X,
M295X

Dual AMD
FirePro D300, D500,
D700

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxIP
Mojo DX

Mojo DX

Nitris DX (no HD capture)
Artist DNxIO

Artist DNxIQ

Artist DNxIV

Artist DNxID

Avid Artist DNxIP

The following Macintosh notebooks are qualified with the current editing applications. The

Qualified Macintosh Notebooks for Media Composer

following applies to the editing system when running on a laptop.

e HD Capture on Macintosh notebooks is not supported

*  Playback in full quality 10 bit mode is not supported

Qualified Macintosh Notebook

Graphics Cards

Supported With

MacBook Pro 15" 2.2 Ghz and higher 17/19 six
core Mid 2018 - Touch Bar & Thunderbolt 3

MacBook Pro 13" 2.7 Ghz quad core Intel core
17 Mid 2018 - Touch Bar & Thunderbolt 3
8 to 16 GB 2133Mhz LPDDR3 Memory

Touch Bar not used by MC

MacBook Pro 15" 2.8 Ghz and higher i7 quad
core Mid 2017 - Touch Bar & Thunderbolt 3
16 GB 2133Mhz

LPDDR3 Memory
Touch Bar not used by MC
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UHD630 AMD
Radeon Pro 555X,
560X

Intel Iris Plus 655

HD630
AMD
Radeon

Pro 555, 560

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP
Mojo DX

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNxIP
Mojo DX

Avid Artist DNxIO
Avid Artist DNxIQ
Avid Artist DNxIV
Avid Artist DNxID
Avid Artist DNXIP
Mojo DX



Qualified Macintosh Notebook

Graphics Cards

Feature Performance

Supported With

MacBook Pro 15" 2.6 Ghz and higher i7 quad HDS530 Avid Artist DNxIO
core Late 2016 - Touch Bar & Thunderbolt3 AMD Avid Artist DNxIQ
16 GB 2133Mhz DDR4 Memory Radeon Avid Artist DNxIV
450,455, 460 Avid Artist DNXID
Touch B t M e
ouch Bar not used by MC Avid Artist DNxIP
Mojo DX
MacBook Pro 15" 2.2 Ghz and higher i7 quad HD5000 Avid Artist DNxIO
core Mid 2015 AMD Avid Artist DNXIQ
. Radeon Avid Artist DNxIV
Ret Th It 16 GB 1600Mh
ctina & Thunderbolt 16 GB 1600Mhz M370X Avid Artist DNXID
DDR3L Memory . .
Avid Artist DNxIP
Mojo DX
MacBook Pro 15" 2.3 Ghz and higher i7 quad Nvidia Avid Artist DNxIO
core Retina Late 2013 and Mid 2014 8 or 16 ~ GeForce Avid Artist DNxIQ
GB 1600Mhz DDR3L Memory GT 750M Avid Artist DNxIV
& Intel HD5000 Avid Artist DNXID
Avid Artist DNxIP
Mojo DX

Feature Performance

A number of features in this editing application are processor-intensive. As a result, you might
experience problems if you are working on an older system. The following chart shows the
hardware that Avid has successfully qualified when using these features. For a list of the
qualified systems, see Qualified Workstations and Laptops.

Feature Description Recommended System
16K projects 64GB RAM minimum

Editing High Resolution, 64 GB RAM minimum, 96 GB

High Frame Rate XAVC-I recommended Dell 7920

Media (UHD/4k in Dell 7820

59.94p)

* Dual Xeon Gold 6154 3.0 Ghz, turbo
up to 3.7 Ghz 18-core (72 cores with
Hyperthreading)

« AMD WX-7100
Storage: 10Gb Ethernet Avid NEXIS

4 streams of media and
color adapters
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Feature Performance

Feature Description

Recommended System

1080p/50 XAVC Long 16 GB RAM minimum
Baseband Capture

Editing High Resolution, 16 GB RAM minimum, 32 GB
High Frame Rate DNxHR recommended

Media (UHD/4k in

59.94p)

Editing High Resolution 16 GB RAM minimum
Media (Higher than 2K+)

DMF and Background 32 GB RAM recommended
Transcode, Background
Render

Media Composer | Cloud 16GB RAM minimum. 24 GB or
higher recommended depending
upon system model.

J2K Capture
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Qualified PC Dual 6 Core or higher
Qualified Mac Pro 6 core or higher, 12
core with Hyperthreading

HP 7840/7820

HP 7640/2620

Dell 7920/7910/ T7610
Dell 7820/7810/T5610
Lenovo P910/P900/
Lenovo P710/P700

+ NVIDIA P5000, M5000 or K5200
and AMD WX-7100
PCle Gen3 Gfx card (recommended)

Mac Pro

* 12 core (24 with Hyperthreading)
3 GHz

* Dual AMD FirePro 500/700 Graphics
card

Storage: 10Gb Ethernet Avid NEXIS

Qualified PC Dual 6 Core or higher

Qualified Mac Pro 6 core or higher, 12
core with Hyperthreading

Qualified PC Dual 6 Core or higher

Qualified Mac Pro 6 core or higher, 12
core with Hyperthreading

17 Quad core or higher with
Hyperthreading

Qualified PC Dual 6 Core or higher

Qualified Mac Pro 6 core or higher, 12
core with Hyperthreading



Feature Performance

Feature

Description

Recommended System

XDCAM Long GOP
9-way MultiCam with
high stream count
sequences

Stereoscopic 3D

XDCAM HD50 Capture

HD RGB 4444
Apple ProRes 4444
DNxHD 4444

AMA (RED)

AMA (QuickTime)

AVCl-Intra Capture

Avid recommends 16 GB RAM

For optimal performance with
Stereoscopic 3D, use these higher
performance systems. Avid
recommends a minimum of 12GB
RAM when using Stereoscopic
3D.

Baseband capture through Nitris
DX, Mojo DX

HD RGB capture requires a high
end workstation with Nitris DX
and fast storage.

AMA is a processor intensive
operation. Older platforms may
not offer optimum performance.
you will get better performance
with higher end workstations.

AMA is a processor intensive
operation. Lower end platforms
may not offer optimum
performance. Highly compressed
codecs such as H.264 will exhibit
minimal real-time performance.

AVC-Intra capture with software
codecs is supported.
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Qualified PC Dual 6 Core or higher

Qualified Mac Pro 6 core or higher, 12
core with Hyperthreading

Storage: 10Gb Ethernet ISIS

Qualified PC Dual 6 Core or higher

Qualified Mac Pro 6 core or higher, 12
core with Hyperthreading

Qualified systems

Qualified PC Dual 6 Core or higher

Qualified Mac Pro 6 core or higher, 12
core with Hyperthreading

Storage: 10Gb Ethernet ISIS

Qualified Xeon Workstations

NOTE: RED plug-in uses the Graphics
Processor. Better performance with high
performance graphics cards.

Recommendation of qualified systems
depends on your planned use of this
feature. Heavy usage of highly
compressed codecs requires the high end
systems. (Dual 6 Core or Dual 8 Core
systems)

24 core and higher Windows systems
only.

Note: If problems are encountered, please
use a Nitris DX w/AVC-I capabilities or
ingest at another resolution like DNxHD
and transcode to AVC 1.



Avid Artist I/O Device Compatibility

Feature Description Recommended System

AVCl-Intra AVC-Intra(AVC-I) is a high 4-Way MultiCam Playback

Fluahty’ low p1t—rat§ HD codecand Dual Quad Core, Dual 6 Core or Dual 8
is very CPU intensive. C
ore Systems

Four Stream Playback:

Dual Quad Core, Dual 6 Core or Dual 8
Core Systems

AMA Workflows: Dual Quad, Dual 6 or
Dual 8 core systems

Avid Artist I/0 Device Compatibility

The following table shows the minimum version Media Composer supported with the Avid
Artist I/O devices.

You must download the appropriate Avid Artist software from your Avid Master Account.

Minimum supported version Media

Device Composer

Avid Artist | DNxIO Media Composer v8.4.1 and higher
Avid Artist | DNxIQ Media Composerv8.8.3 and higher
Avid Artist | DNXIV Media Composer v8.10 and higher
Avid Artist | DNxIP Media Composer v2018.8

Avid Artist | DNxID Media Composer v2018.9

Compatibility Chart

The following table lists the NVIDIA® driver, QuickTime®, Windows Media™, shared storage,
Sony® XDCAM™, Panasonic® P2, and Avid Artist Series versions that were qualified with the
Avid editing applications. You can also refer to Documentation and version matrix.
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http://avid.force.com/pkb/articles/en_US/compatibility/en267087
https://my.avid.com/account/orientation

Compatibility Chart

IMPORTANT: For information on third party support (for example, Sorenson, Boris,
etc) see the third party’s web site.

Item Versions Comments

QuickTime Support  v7.7.9 (Windows) Note: QuickTime v10X does not include
v10.x, (v7.x legacy) (Macintosh) QuickTime Pro options.

Note: QuickTime is not supported with

Windows 10.
Windows Media Windows Media Player 12 (for ~ If you do not have Windows Media
Version Support Windows 7) Player, access the download at

www.microsoft.com.

Windows Media export compatibility is
subject to Microsoft Windows Media

updates.
Avid Interplay See Knowledge Base articleon ~ IMPORTANT: The Avid Interplay
Support compatibility. components that get installed on the

editing application must be updated to
the Avid Interplay version that is released
with the editing application. These
include the Media Indexer, Interplay
Access, Interplay Framework, Interplay
Transfer Client and ProEncode Client.
The Avid Interplay Server components
can remain on the previous releases listed
as supported. For details, see the “Avid
Editing Application Compatibility with
Interplay Releases” doc on the

Knowledge Base.
NVIDIA Driver v431.02 See “Setting up the NVIDIA Card” on
Support page 38.

For setting up the driver for stereoscopic,
see the NVIDIA setup info in the
Stereoscopic 3D Workflow Guide.

Shared Storage Avid NEXIS and Avid ISIS®. See “Shared Storage Support” on
Support page 39.
Sony XDCAM driver v2.13 (XDCAM Transfer for The VFAM firmware version for
Macintosh) PDW-U1 is 2.600.
Windows FAM v2.3.2and VFAM 11e PDW-U2 is 2.810.

The driver can be downloaded from

5.0.2
v Sony's website http://esupport.sony.com/.
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Avid Editing Application Compatibility with Pro Tools

Item Versions Comments

Panasonic P2 drive (Macintosh) v3.1.7 There is currently no P2 writeback
(Windows) v2.24 support for Macintosh clients.

Avid Artist Series EuControl software v3.4 See the User’s Guide for information on

(Euphonix) Artist Series Color setup information.

Avid Editing Application Compatibility with
Pro Tools

General Co-Installation Notes:

Install Pro Tools first and then Media Composer.

You must uninstall all older versions of Media Composer or Pro Tools before installing
newer versions.

Co-install does not support both applications launched simultaneously.

When you uninstall Pro Tools, choose to uninstall just the application and not the audio
drivers or the editing application no longer sees the devices. On a Macintosh Pro Tools 10
system, this is named the “Safe Uninstall.” On a Macintosh Pro Tools 11 system no
uninstallation is required. On a Windows Pro Tools 10 or 11 system, you must select the first
uninstall option - “Pro Tools Only” - which is not selected by default.

Mojo SDI will not be supported with Media Composer or Pro Tools 11, but can still be
connected in a co-install configuration for use with Pro Tools 10.

If you install and configure Avid Mojo DX or Nitris DX hardware on your system, the
editing application does not use any connected Pro Tools audio device for audio input/output
operations. You can also use these audio devices with a software-only version of your Avid
editing application.

If you run into any issues, uninstall both applications and reinstall Pro Tools first, and then
reinstall your editing application.

Media Composer v5.0 and later and Pro Tools v8.0.3 and later do not include support for the
Original Mbox. If you want to use the Original Mbox, you should use Media Composer v4.x
and Pro Tools v8.0.1 instead.

If you want to install your Avid editing application on a system with the Pro Tools Avid
Video Engine installed, you must use one of the following configurations:

- Media Composer v5.5/NewsCutter v9.5 and later with Pro Tools v9.0 or later.

- Media Composer v5.0.x/NewsCutter v9.0.x with Pro Tools v8.5 or earlier.
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Co-installation Configurations and Audio Device Support

Co-installation Configurations and Audio Device
Support

Avid Pro Tools Applications

MC/NC MC/NC
Pro Tools Software with Mojo MC/NC/
Product Only DX with Nitris DX
Pro Tools Co-install Co-install Co-install

Software Only

Pro ToolsfHD  Co-install/ Co-install Co-install
Native Audio Device

Pro ToolsHD  Co-install/ Co-install Co-install
Audio Device

Pro Tools/HD, Not Tested  Not Tested  Not Tested
with chassis

Avid Mbox Family Audio Devices (3rd Generation)

Audio MC/NC

Device Software MC/NC with MC/NC/
(Interface) Only Mojo DX with Nitris DX
Mbox Co-install/ Co-install Co-install
(USB) Audio Device

Mbox Pro Co-install/ Co-install Co-install

Audio Device

Mbox Mini  Co-install/ Co-install Co-install
(USB) Audio Device

Avid Mbox 2 Family Audio Devices

Audio MC/NC

Device Software MC/NC with MC/NC/
(Interface) Only Mojo DX with Nitris DX
Mbox 2 Co-install/ Co-install Co-install
(USB) Audio Device
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External Controllers

Other Avid Audio Devices

Audio MC/NC
Device Software MC/NC with MC/NC/
(Interface) Only Mojo DX with Nitris DX
Mbox 2 Pro Co-install Co-install Co-install
(1394)
Mbox 2 Co-install/ Co-install Co-install
Mini (USB) Audio Device
Mbox 2 Co-install Co-install Not tested
Micro
(USB)
Audio MC/NC
Device Software MC/NC with MC/NC/
(Interface) Only Mojo DX with Nitris DX
Digi 002 Co-install/ Co-install Co-install
(1394) Audio Device

(Windows)
Digi 003 Co-install Co-install Co-install
(1394)
Eleven Rack Not Supported Not Supported Not Supported

(USB)

Fast Track  Audio Device Not Supported
Pro (USB)

Not Supported

External Controllers

Your Avid editing application supports the following external fader controllers or mixers for
automation gain and pan recording or as control surfaces:

*  Digi 002 (Windows only)
+ Command|8

*  Avid Artist Control

*  Avid Artist Mix
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External Controllers

*  Avid Artist Transport
*  Avid Artist Color

External controllers or mixers are optional. They are not required for you to perform automation
gain or pan recording on an Avid editing system.

The following table compares Avid external controllers and mixers.

Avid

Digi 002 Command| Artist Avid Avid Artist Avid Artist
Feature (MC only) 8 Control Artist Mix Transport Color
Control surface Yes Yes Yes Yes Yes
for transport (transport
controls and only, no soft
other functions keys)
Provides audio Yes No No No No
play, input, and
output
Record Yes Yes Yes Yes No
automation
gain
Record Yes Yes Yes Yes No
automation pan
Flying faders ~ Yes (8) Yes (8) Yes (4) Yes (8) No
Touch-sensitive Yes Yes Yes Yes No
faders
Touch-sensitive No No Yes Yes No
panners
Solo/mute Yes Yes Yes Yes No
Supports audio No? No No No No
mixing
Latch mode Yes Yes Yes Yes No
(also known as
Snap mode)
Number of 1024 1024 1024 1024 Not applicable
steps of fader
accuracy
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Setting up the NVIDIA Card

Avid
Digi 002 Command| Artist Avid Avid Artist  Avid Artist
Feature (MC only) 8 Control Artist Mix Transport Color

a. The Digi 002 can be used as a standalone audio mixer but not at the same time as it is being used as an automation gain or
automation pan controller or control surface.

For more information on using these external fader controllers or mixers, see “Recording
Automation Gain or Automation Pan Information” in the Help.

Setting up the NVIDIA Card

To set up the NVIDIA card, you must make sure you have the correct display driver version
(install the display driver if necessary, and set the correct display settings. See the “Compatibility
Chart” on page 32 for information on the supported driver(s).

Prior to setting up the NVIDIA card, check to make sure you have the correct display driver
version. If you do not have the correct NVIDIA driver, you can install it from the Nvidia website
- Nvidia.com.

To check the NVIDIA display driver version:

1. Right-click the Desktop and select NVIDIA Control Panel. You can also open the Windows
Control Panel and double-click the NVIDIA Control Panel icon.

2. Click System Information at the bottom left corner of the NVIDIA Control Panel.

The version number is listed in the Graphics card information section on the ForceWare
version line.

To install the NVIDIA display driver:
1. Download the applicable Nvidia driver from the Nvidia website - Nvidia.com.
2. Double-click the file for the applicable driver.

3. Follow the on-screen instructions, and then restart your system.

To setup multiple displays:
1. Right-click the Desktop, and select Nvidia Control Panel.
2. In the settings window in the left of the window, click Set up multiple displays.

3. Select or deselect the desired monitors listed.
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Shared Storage Support

To set the Driver for Avid Editing Environments

1.

A S

Right-click the Desktop, and select Nvidia Control Panel.

Click Manage 3D Settings.

Click the Global Setting tab.

Under Global presets, select Base Profile.

Scroll to locate the Power Management Mode. Select Prefer maximum performance.
Click Apply.

Reboot after installing the Nvidia software even if you are not prompted to do so.
Never use the Windows “roll back driver” feature on the Nvidia driver. The driver version must
match the rest of the components the Nvidia installer installs.

Shared Storage Support

For information on Shared Storage Support, see the Avid NEXIS and Avid ISIS tables in the
following document:

http://resources.avid.com/SupportFiles/Attachments/MediaCentral_Compatibility_Matrix.pdf
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Shared Storage Support

Legal Notices
Product specifications are subject to change without notice and do not represent a commitment on the part of Avid Technology, Inc.

This product is subject to the terms and conditions of a software license agreement provided with the software. The product may
only be used in accordance with the license agreement.

This product may be protected by one or more U.S. and non-U.S patents. Details are available at www.avid.com/patents.

No part of this document may be reproduced or transmitted in any form or by any means, electronic or mechanical, including
photocopying and recording, for any purpose without the express written permission of Avid Technology, Inc.

Copyright © 2019 Avid Technology, Inc. and its licensors. All rights reserved.
Portions © Copyright 2003-2007 of MOG Solutions.

Attn. Government User(s). Restricted Rights Legend

U.S. GOVERNMENT RESTRICTED RIGHTS. This Software and its documentation are “commercial computer software” or
“commercial computer software documentation.” In the event that such Software or documentation is acquired by or on behalf of a
unit or agency of the U.S. Government, all rights with respect to this Software and documentation are subject to the terms of the
License Agreement, pursuant to FAR §12.212(a) and/or DFARS §227.7202-1(a), as applicable.

Trademarks

Avid, the Avid Logo, Avid Everywhere, Avid DNXHD, Avid DNXHR, Avid Nexis, AirSpeed, Eleven, EUCON, Interplay, INEWS, ISIS,
Mbox, MediaCentral, Media Composer, NewsCutter, Pro Tools, ProSet and RealSet, Maestro, PlayMaker, Sibelius, Symphony, and
all related product names and logos, are registered or unregistered trademarks of Avid Technology, Inc. in the United States and/or
other countries. The Interplay name is used with the permission of the Interplay Entertainment Corp. which bears no responsibility
for Avid products. All other trademarks are the property of their respective owners. For a full list of Avid trademarks, see:
http://www.avid.com/US/about-avid/legal-notices/trademarks.

Adobe and Photoshop are either registered trademarks or trademarks of Adobe Systems Incorporated in the United States and/or
other countries. Apple and Macintosh are trademarks of Apple Computer, Inc., registered in the U.S. and other countries. Windows

is either a registered trademark or trademark of Microsoft Corporation in the United States and/or other countries. All other
trademarks contained herein are the property of their respective owners.

Avid Media Composer ReadMe + Created 7/23/19
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